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ch as lines, rectangles, 

r

4.1. Drawing Basic Shapes  

The software provides a drawing tool you can use to create simple or elaborate drawing shapes su
circles, arcs etc.  
 
To create a drawing shape, click the shape on the Draw Toolbar (See Section 1.4.2.3 Draw Toolba  for details), or use the 

 Draw menu (See Section 1.4.1.5 Draw menu command on the for details). Then, move the mouse to the position you want 
hape to bring up the 

d, pattern, FG/BG 
Color…of the shape. 

click the 

to place the shape and click the left button. To set up a drawing shape, double-click the s
corresponding properties dialog, which can then allow you to set up the color and style of the line/outline

 
Note: If you don’t see the Draw Toolbar pictured below in the lower left corner of the pro ram window, please 

enu. 
g

Draw Toolbar command on the View m

 
 
The following is a sample of the basic shapes: 
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4.1.1. Drawing Dots 

1. In the Draw menu or Draw toolbar, click Dot . 

2.  Move the cursor onto the screen where you want to draw a dot. A dot with default settings will display and move 

3.  Click the desired position o ll be at the clicked position. 

4.  Double-click the dot to brin  
 

The following is an exampl

along with the cursor. 

n the screen to place the dot. The center of the dot wi

g up the Dot dialog box and then modify the settings of the dot. 

e of the Dot dialog box. 

 

 
 

The following table descri t dialog box. bes each property in the Do

Property Description 

Style 

Select one of the dot styles listed below:  

 

Color Specifies the dot color.  

X Specifies the X coordinate of the upper-left corner of the dot. 
Posi

Y Specifies the Y coordinate of the upper-left corner of the dot. 
tion 

 

5.  You can click the following icons in the Draw toolbar to modify the properties of the dot. 

Click Icon To 

 
Select a style for the dot. 

 
Select a color for the dot. 
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4.1.2. Drawing Lines 

1 lick.  In the Draw menu or Draw toolbar, c  Line  to draw a straight line. You can also click Horizontal Line  

ntal line or click Vertical Line to draw a horizo  to draw a vertical line. 

gs will display and move 

3.  sition on the screen to place the line. The start  the clicked position. 

4.  Drag the handle at the s  the end point to adjust 
the position of the en  p

2.  Move the cursor onto the screen where you want to draw a line. A line with default settin
along with the cursor. 

Click the desired po point of the line will be at

tart point to adjust the position of the start point. Drag the handle at
oint. d

 The picture on the left shows the two handles of a line. Position the mouse 
to pointer over one of the handles. When the cursor changes , drag the handle 

 until the line has the length and slope you want.  
 
5.  Left-click and hold down the mouse button until the cursor becomes a cross icon  to move the line. 

ck the line to bring up the Line dialog box and then modify the settings of the line. The following is a6.  Double-cli  
sample box.  of the Line dialog 
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The follow  describes each property in the Line  ing table  dialog box.

Property Description 
Type pe of line: General, Horizontal, or Vertical. Specifies the ty
Style 

                     

Click the button to select the 
line style from the dropdown 

the right: window shown on 

Static anged. Check this option if the color of the line will not be ch
Controlled By Bit Check this option if the color of the line will be controlled by the specified bit.
Blink Check this option so the line will blink. You have to choose the blink effects 

or to Off state color.  that change the color of the line from its On state col
Blink(Enable king by the specified bit.d by Bit) Check this option if you want to enable the line blin
State Select the state that you want to view or define the color for. 
Color . Specifies the line color for the selected state

Color 

Control Bit s the bit that contro or or enables the color blinking.  

Click 

Specifie ls the col

 to enter the bit tag.  to enter the bit address. Click 
Start/End Point Select this op ne to have a shape  tion if you want the li  at the start/end point.
Type Click the drop  the type for Start/End Pointdown list to select  

                                    

Filled ou want the shape to be filled with the line color. Select this option if y

Start / End 
Point 

Size ze. 

End Point Type: Start Point Type:

Specifies the shape si
Visibility Co
By Bit 

the line will be shown or hidden by the specified bit. ntrolled Check this option if 

Control Bit Specifies the bit that shows or hides the object.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility
Control 

V s the state (On or Off) that makes the line visible. 

 

isible State Specifie
X rdinate of the start point. 1 The X coo
Y1 The Y coordinate of the start point. 
X2 The X coordinate of the end point. 

Termin  

Y2 The Y coordinate of the end point. 

al

 

7.  You can click the following icons in the Draw toolbar to modify the properties of the line. 

Click Icon To 

 
Select a style for the line. 

 
Select a color for the line. 
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4.1.3. Drawing Polylines 

 

1.  In the Draw menu or Draw toolbar, click Polyline to draw a polyline. 

2.  Move the cursor onto the screen where you want to draw a polyline, and click the position where you want the start 

ts needed for nodes in the polyline. 

e. 

5.  Dra

6.  Dra   

point of the polyline to be at. 

3.  Continue clicking on the screen to place as many poin

4.  Right-click to place the last point for the polyline and complete the polylin

g one blue handle of the p

g one black handle of the p

olyline at a time to resize the polyline.  

olyline at a time to adjust the node positions of the polyline.
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7.  Right-click anywhere on th obje rt a new 

point for the polyline. Or e object 
pop-up menu to delete the point. 

e polyline and use th
right-click the existing po

e Insert Point command on the 
int of the polyline and use the 

ct pop-up menu to inse
Delete Point command on th

Pop-up menu Description 

Insert Point 

Add a point at the specified position. 

   
 

Delete Point 

Delete a selected point. 

   
 

The picture on the left shows all the blue and black handles of a polyline. 
Position the mouse pointer over one of the handles. When the cursor 
changes to  or  or  or , drag the handle until the polyline i
the shape and size you want.  
 

s 
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8.  Double-click the polyline to bring up the Polyline dialog box and then modify the settings of the polyline. 

 

The following is a sample of the Polyline dialog box. 

 

 

The following table describ ch property in the Polyline dialog box. es ea

Property Description 
Line Style Specifies the style of the polyline. 

Static Check this option if the color of the polyline will not be changed. 
Controlled B will be controlled by the specified y Bit Check this option if the color of the polyline 

bit. 
Blink u have to choose the blink 

om its On state color to Off state 
Check this option so the polyline will blink. Yo
effects that change the color of the polyline fr
color.  

Blink(Enable ption if you want to enable the polyline blinking by the specified d by Check this o
Bit) bit. 
State ate that you want to view or define the color for. Select the st
Color Specifies the line color for the selected state. 

Color 

 s the color blinking.  Control Bit Specifies the bit that controls the color or enable

Click  to enter the bit address. Click  to enter the bit tag. 
Start Point Select this option if you want the polyline to have a shape at the start point. 
Type Specifies the shape type. 
Filled Select this option if you want the shape to be filled with the line color. 

Start Point 

Size Specifies the shape size. 
End Point Select this option if you want the polyline to have a shape at the end point. 
Type Specifies the shape type. 
Filled Select this option if you want the shape to be filled with the line color. 

End Point 

Size Specifies the shape size. 
Continued  
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Property Description 

Visib
By Bit

ility Co
 

ill be shown or hidden by the specified bit. ntrolled Check this option if the polyline w

Control Bit  Specifies the bit that shows or hides the polyline. 

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility
Control 

Visible State  

 

 Specifies the state (On or Off) that makes the line visible.
Left The X coordinate of the upper-left corner of the bounding rectangle of the 

polyline. 
Top t corner of the bounding rectangle of the 

polyline. 
The Y coordinate of the upper-lef

Width The width of the bounding rectangle of the polyline. 

Profile 

Height The height of the bounding rectangle of the polyline. 
 

9.  You e Draw toolbar to modify the properties of the polyline. can click the following icons in th

Click Icon To 

 
Select a style for the polyline. 

 
Select a color for the polyline. 
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4.1.4. Drawi ctangles 

1 ra

ng Re

.  In the D w menu or Draw toolbar, click Rectangle to draw a normal rectangle. You can also click Round 

Rectangle to draw a round rectangle or click Clipped Rectangle to draw a clipped rectangle. 
ult settings will display 

ng with the cursor.  
3.   rectangle will be at the 

4.  Drag one hand e 

2.  Move the cursor onto the screen where you want to draw a rectangle. A rectangle with defa
and move alo

Click the desired 
clicked position.  

position on the screen to place the rectangle. The upper-left corner of the

of the rectangle at a time to resize the rectangle. l
The picture on the left shows the eight handles of a rectangle. Posi
over one of the handl

tion the mouse pointer 
es. When the cursor changes to 

 

Double-click the rectan5.  gle 
following is a sample

to bring up the Rectangle dialog box and then modify the settings of the rectangle. The 
 of the Rectangle dialog box. 

 

 

 

The following table describes each property in the Rectangle dialog box. 

Property Description 

Type 

Specifies the type of the rectangle. There are three types: Normal, Round, or Clipped. 

Normal Round Clipped 

    
Continued  

 or  or  or , drag the 
handle until the rectangle is the shape and size you want.  
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Property Description 
Number
of Dots 

ecifies the radius  Specifies the size of the clipped corners if the rectangle is a clipped rectangle. Sp
of the round corners if the rectangle is a round rectangle. 

3D 

ecifies the 3D vis t for the rectangle. sed, or Sunken. Sp ual effec There cts: Flat, Raiare three effe

Samples DEffects escription 
You can specify the Color and 

the Border if it is 
cted.  

 
Thickness field is not available 
when flat is selected.  

Style for 
sele

Flat 

 
Raised 

 

You can specify the color for the 
top and left edges. The software 
will darken the specified color 
and draw in the bottom and right 
edges for you. 
 
Border and Style field is not 

when Raised is available 
selected. 
 

Sunken 

 

You can specify the color for the 
bottom and right edges. The 
software will darken the specified 
color and draw in the top and left 
ed . 
 
Border and Style field is not 
available when Sunken is 
selected. 

ges for you

 
Continued  
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Property Description 

Static Check this option if the color of the rectangle will not be changed. 

Controlled B rolled by the specified y Bit Check this option if the color of the rectangle will be cont
bit. 

Blink Check this option so the rectangle will blink. You hav
effects that change the color of the rectangle from its On 

e to choose the blink 
state Border and Solid 

 option settings.  option settings to Off state Border and Solid
Blink(Enabl  
Bit) 

 rectangle blinking by the specified ed by Check this option if you want to enable the
bit. 

Color 
Control 

ontrol Bit
s the blinking.  

C  
Specifies the bit that controls the color or enable

Click  to enter the bit address. Click  to enter the bit tag. 
State lors for. Select the state that you want to view or define the co

Border rder. Check this option if you want the rectangle to have a bo
Thickness Specifies the thickness of the border.  
Color the selected state. Specifies the border color for 

Border 

e Styl Select a line style for the border. 

Solid 
ctangle is filled 

ilable when Border is 
Check this option if you want the rectangle to be solid. A solid re
with the specified pattern and colors. This field is ava
selected. 

Pattern  state. Specifies the fill pattern for the selected

FG Color olor for the selected state that will be used for painting the black 
attern. 

Specifies the c
part of the fill p

Solid 

d for painting the white BG Color Specifies the color for the selected state that will be use
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the rectangle.  
Top The Y coordinate of the upper-left corner of the rectangle. 

Profile 

 
Width The width of the rectangle. 
Height The height of the rectangle. 
Visibility k this option if the rectangle will be shown or hidden by the specified bit. Controlled By Bit Chec

Control Bit 
Sp

Visibility

eci s the bit that shows or hide gle.  fie s the rectan

Click  to enter the bit  to enter the bit tag. address. Click 

 
Control 

Visible State Specifies the state (On or Off) that makes the rectangle visible. 

6.  You can c fy the properties of the rectangle. cli k the following icons in the Draw toolbar to modi

Click Icon To 

 
Select a line style for the border. 

 
Select a color for the border. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.5. Drawing Circles 

1.  In the Draw menu or Draw toolbar, click Circle to draw a circle. 

2.  Move the cursor onto the screen where you want to draw a circle. A circle with default settings will display and move 

3 en to place the circle. The center of the circle will be at the clicked position. 

he nges to 

along with the cursor. 

. Click the desired position on the scre

4. Position the mouse pointer over the handle on the edge of the circle. When t  cursor cha  or , drag 
want. 

5. e circle. When the cursor changes to 

the handle until the circle is the size you 

Position the mouse pointer over the handle on the center of th , left-click the 
cente d down the button to move the circle. r and hol

 

ck the circle to b

CHAPTER 4   DESIGNING SCREENS

6.  Double-cli r

The following is a samp

ing up the Circle dialog box to modify the settings of the circle.  

le of the Circle dialog box. 

 

The picture on the left shows the two handles of a circle. 
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The fol le describes each property in the C ox. lowing tab ircle dialog b

Property Description 
Static Check this option if the color of the circle will not be changed. 

Controlled B d by the specified bit. y Bit Check this option if the color of the circle will be controlle
Blink Check this option so the circle will blink. You have to ch

that change the color of the circle from its On state Outlined and Solid option
oose the blink effects 

 
ion settings.  settings to Off state Outlined and Solid opt

Blink(Enable
Bit) 

rectangle blinking by the specified d by Check this option if you want to enable the 
bit. 

Color 
Control

trol Bit or or enables the blinking. 

 

Con Specifies the bit that controls the col

Click  to enter the bit addres  to enter the bit tag. s. Click 
State r. Select the state that you want to view or define the colors fo

Outlined he circle to be outlined. Check this option if you want tOutlin
r 

e 
Colo Specifies the outline color for the selected state. 
Solid d circle is filled with the 

attern and colors. 
Check this option if you want the circle to be solid. A soli
specified p

Pattern he selected state. Specifies the fill pattern for t
FG Color that will be used for painting the black 

ll pattern. 
Specifies the color for the selected state 
part of the fi

Solid 

nting the white BG Color Specifies the color for the selected state that will be used for pai
part of the fill pattern. 

X ceThe X coordinate of the nter of the circle. 
Y The Y coordinate of the center of the circle. 

Center 
& 
Radius

Radius The radius of the circle. 
 

Visibility Check this option if the circle will be 
Controlled By Bit 

shown or hidden by the specified bit. Visibility 

Control Bit Specifies the bit that shows or hides the circle.  

Click  to enter the bit address. Click  to enter the bit tag. 

Control 

Visible State Specifies the state (On or Off) that makes the circle visible. 
 

7.  You can click the following icons in the Draw toolbar to modify the properties of the circle. 

Click Icon To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.6.

1 raw toolbar, click Ellipse 

 Drawing Ellipses 

CHAPTER 4   DESIGNING SCREENS

.  In the Draw menu or D to draw an ellipse.

ettings will display and 

per-left corner of the bounding rectangle of the 
elli

4.  Dra

 

2.  Move the cursor onto the screen where you want to draw an ellipse. An ellipse with default s
move along with the cursor. 

3.  Click the desired position on the screen to place the ellipse. The up
pse will be at the

g one handle of 

 clicked position. 

the ellipse at a time to resize the ellipse.  

 

The picture on the left shows the eight handles of an ellipse. Position the mouse pointer 
 of the handles. When the cursor changes to 

5.  Double-click the ellipse to bring u

The following is a sample of the Ellipse dialog box. 

p the Ellipse dialog box and then modify the settings of the ellipse.  

 

 

 

over one   or  or  or , drag the 
handle until the rectangle is the shape and size you want.  
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The fo le describes each property in the E  box. llowing tab llipse dialog

Property Description 
Static Check this option if the color of the ellipse will not be changed. 

Controlled d by the specified bit. By Bit Check this option if the color of the ellipse will be controlle
Blink Check this option so the ellipse will blink. You have to 

that change the color of the ellipse from its On state 
choose the blink effects 

Outlined and Solid option 
n settings.  settings to Off state Outlined and Solid optio

Blink(Enab  
Bit) 

llipse blinking by the specified bit. led by Check this option if you want to enable the e

Color 
Control

trol Bit r or enables the blinking.  

 

Con Specifies the bit that controls the colo

Click  to enter the bit addres  to enter the bit tag. s. Click 
State r. Select the state that you want to view or define the colors fo

Outlined he ellipse to be outlined. Check this option if you want tOutlin
r 

e 
Colo Specifies the outline color for the selected state. 
Solid lid ellipse is filled with 

ed pattern and colors. 
Check this option if you want the ellipse to be solid. A so
the specifi

Pattern Specifies the fill pattern for the selected state. 
FG Color  for painting the black Specifies the color for the selected state that will be used

part of the fill pattern. 

Solid 

 used for painting the white BG Color Specifies the color for the selected state that will be 
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the bounding rectangle of the ellipse.
Top e bounding rectangle of the ellipse.The Y coordinate of the upper-left corner of th
Width The width of the bounding rectangle of the ellipse. 

Profile

 the ellipse. 

 

Height The height of the bounding rectangle of
Visibility 
Controlled By Bit 

Check this option if the ellipse will be shown or hidden by the specified bit. 

Control Bit hows or hides the ellipse.  Specifies the bit that s

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the ellipse visible. 
 

6.  You can click the following icons in the Draw toolbar to modify the properties of the ellipse. 

Click Icon To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.7. Drawing Arcs 

1.  In the Draw menu or Draw toolbar, click Arc to draw an arc. 

2.  Move the cursor onto the screen where you want to draw an arc. An arc with default settings will displ
along with the cursor. 

ay and move 

c. The upper-left corner of the bounding rectangle of the arc 
wil

4.  Dra

3.  Click the desired position on the screen to place the ar
l be at the clicke

g one handle o

d position. 

f the arc at a time to change the shape of the arc.  

CHAPTER 4   DESIGNING SCREENS

 

he arc to bring up the Arc dialog box and then modify the settings of the arc.  

ple of the Arc dialog box. 

The picture on the left shows the handles of an arc. The blue and
arc. The black handles of the two ends of the arc are for c

 h les are for shaping the 
hanging the ends' angles. The 

g the arc to be a part of a circle. 

Position the mouse pointer over one of the handles. When the cursor changes to 

black handle at the center of the arc is for forcin

 or 
 or 

5.  Double-click t

 

The following is a sam

 

 

The followi  table descri g box. ng bes each property in the Arc dialo

Property Description 
Color Specifies the color of the arc. 

L inate of the upper-left corner of the bounding rectangle of the arc. eft The X coord
Top The Y coordinate of the upper-left corner of the bounding rectangle of the arc. 
Width The width of the bounding rectangle of the arc. 

Profi

Height The height of the bounding rectangle of the arc. 

le 

 

6.  You can click the following icons in the Draw toolbar to modify the properties of the arc. 

Click Icon To 

 
Select a color for the arc. 

 

 or , drag the handle until the arc is the shape and size you want.  
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4.1.8. Drawing Pie Shapes 

1.  In the Draw menu or Draw toolbar, click Pie to draw a pie shape. 

2.  Move the cursor onto the screen where you want to draw a pie shape. A pie shape with defa
and move along with the cursor. 

ult settings will display 

e shape. The upper-left corner of the bounding rectangle of 

4.  Dra

3.  Click the desired position on the screen to place the pi
the pie shape will be at t

g one handle of the p

he clicked position. 

ie shape at a time to change the pie shape.  

 

ble-click the pie shape to bring up the Pie dialog box to modify the settings of the pie shape.  

The picture on the left shows the handles of a pie shape. The blue handles are for 
nds of the pie are for 

g  the center of the pie 
s of the 

Position the mouse pointer over one of the handles. When the cursor changes to

changing the pie shape. The black handles at the two e
changin  the size of the pie. Clicking the black handle at
applies the radius to the entire pie and can be used to change the radiu
pie. 

5.  Dou

 
The foll leowing tab  describes each property in the Pie dialog box. 

Property Description 
Outlin hape to be outlined. ed Check this option if you want the pie sOutlin

lor
e 

Co  Specifies the outline color. 
Solid Check this option if you want the pie shape to be solid. A solid pie shape is filled with the 

specified pattern and colors. 
Pattern Specifies the fill pattern. 
FG Color Specifies the color that will be used for painting the black part of the fill pattern. 

Solid 

BG Color Specifies the color that will be used for painting the white part of the fill pattern. 
Left The X coordinate of the upper-left corner of the bounding rectangle of the pie shape. 
Top The Y coordinate of the upper-left corner of the bounding rectangle of the pie shape. 
Width The width of the bounding rectangle of the pie shape. 

Profile 

Height The height of the bounding rectangle of the pie shape. 
 

 or  or  or , drag the handle until the pie is the shape and size you 
t
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6.  Y k the following icons in the Draw toolb  modify the properties of the pie shape ou can clic ar to

CHAPTER 4   DESIGNING SCREENS

Cl oick Ic n To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.9. Drawing Polygons 

1.  In the Draw menu or Draw toolbar, click Polygon to draw a polygon. 

2.  Move the cursor onto the screen where you want to draw a polygon and click the position where you want the first 

oints needed for vertices in the polygon. 

n. 

5.  Dra

6.  Dra .  

vertex of the polygon to be at. 

3.  Continue clicking on the screen to place as many p

4.  Right-click to place the last vertex for the polygon and complete the polygo

g one handle of the polygon

g one black handle of the po

 at a time to resize the polygon.  

lygon at a time to adjust the vertex positions of the polygon

T r  a polygon. The blue 
 resizing the polygon. The black handles are for moving 

the vertices of the polygon.  

les. When the cursor 
changes to 

he pictu e on the left shows the handles of 
handles are for

Position the mouse pointer over one of the hand
 or  or  or , drag the handle until the polygon is 

the s ize you want.  hape and s
  

7.  Right-click anywhere on th rt a new 
point for the d on the 
object pop-up menu to dele

e polygon and use th
polygon. Or right-click the existing point

te the point. 

e Insert Point command on the 
 of the polygon and use the Delete Po

object pop-up menu to inse
int comman

Pop-up menu Description 

Insert Point 

Add a point at the specified position. 

   
 

Delete Point

Delete a selected point. 
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8. Double-click the polygon to bring up the Polygon dialog box to modify the settings of the polygon.  

 

 

The follo crwing table des ibes each property in the Polygon dialog box. 

Property Description 
Static o ill not be changed. Check this option if the c lor of the polygon w

Controlled By Bit bit.  Check this option if the color of the polygon will be controlled by the specified 

Blink e polygon will blink. You have to choose the blink effects 
gon from its On state Outlined and Solid option 

settings to Off state Outlined and Solid option s

Check this option so th
that change the color of the poly
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ettings.  
Blink(Enabled by 
Bit) 

Check this option if you want to enable the polygon blinking by the specified bit.

Color 
trol 

Control Bit 
Specifies the bit that controls the color or enables the blinking.  

Click 

Con

 to enter the bit address. Click  to enter the bit tag. 
State Select the state that you want to view or define the colors for. 

Outlined Check this option if you want the polygon to be outlined. 
Thickness Specifies the thickness of the outline. 

Outline 

Color Specifies the outline color for the selected state. 
Continued  
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Property Description 

Solid e polygon to be solid. A solid polygon is filled with Check this option if you want th
the specified pattern and colors. 

Pattern he fill pattern for the selected state. Specifies t

FG Color  for painting the black 
 

Specifies the color for the selected state that will be used
part of the fill pattern.

Solid 

BG Color Specifies the color for the selected state that will be used for painting the white 
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the bounding rectangle of the 
polygon. 

Top er of the bounding rectangle of the The Y coordinate of the upper-left corn
polygon. 

Width The width of the bounding rectangle of the polygon. 

Profile 

 n. Height The height of the bounding rectangle of the polygo
Visibility 

lled
Bit 

n or hidden by the specified bit. Contro  By Check this option if the polygon will be show

Control Bit 
gon.  

Click 

Specifies the bit that shows or hides the poly

 to enter the bit address. Click  to enter the bit tag. 

Visibility 
Contro

s the state (On or Off) that makes the polygon visible. 

l 

Visible State Specifie
 

9.  You can c y the properties of the polygon.  cli k the following icons in the Draw toolbar to modif

Cl oick Ic n To 

 
Select a line style for the border. 

 
Select a color for the border. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.10. Drawing Text Objects 

1.  In the Draw menu or Draw toolbar, click Text . 

2.  Move the cursor onto the screen where you want to draw a text object. A text object with defa
and move along with the cu

ult settings will display 
rsor. 

ounding box of the text 

4.  D t to bring up the Text Object dialog box and then modify the settings of the text object. 
og box contains the following three pages: 

■
 4.1.10.1.

3.  Click the desired position on the screen to place the text object. The upper-left corner of the b
at the clicked position. object will be 

ouble-click the text objec
This dial

   General 
ibed in SectionDescr  

■   Shape 
Described in Section 4.3.4 

■   Visibility 
Described in Section 4.4.6.  

ote 1: You can use the Text toolbar to modify the properties of the text object's

 

N  text instantly. 

Note 2: You can use the Draw toolbar to modify the properties of the text object's shape instantly. 

Tip: By default, the Auto Text Resizing on the Edit menu is checked and the related icon on the Edit toolbar is sunken. If 
you don’t want to resize the text when resizing the object, you need to uncheck the Auto Text Resizing command 

on the Edit menu or click the sunken icon  on the Edit toolbar to make the font size fixed.  
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4.1.10.1. General Settings 

CHAPTER 4   DESIGNING SCREENS  

ral settings for text objects. This section describes how to define the gene

 

 

 

 

 

 

 

 
The above is an example of the General page of the Text Object dialog box. 
 

In this edit box, you can view 
and edit the current text of the 

cted language.  current sele

Click to select a text 
from the text database 
of the current selected 
language. 

Select a text from the 
dropdown text table.  

Click to change text 
table. You can select 
the text or edit the text 
in the selected table. 
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The f scribes each property in the Ge  ollowing table de neral page.

Property Description  

Language The language that you are setting the text for. 
Shape Check this option if you want the text object to have a frame as its ba

page appears in th
ckground. The Shape 

e dialog box when the option is selected. 
Use the text of the first 
language for all o
languages 

 f nguage regardl  ther Check this item so the text object always shows the text of the irst la
what the current language is. 

ess of

Font The font of the current text. You can use the drop-down list to select a font, or click  to 
bring up the Font Templates dialog box and select a font for the current text. You can 
change the font templates before selecting a font in that dialog box. 

<E
<Co

dit >
m o ected language.  
 Box
bo B

 / 
The current text of the currently selx> 

Text 
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 /  Click  to view and edit the text for the selected language in this edit box, or click  to 
xt Database. You can select a text from dropdown text table that lists all the texts from Te

change the text database before selecting a text.  
Color The color of the text. To specify the color, click the corresponding Color icon and select a 

 fro r pacolor m the Colo lette. 
Transparent  this to make th ckground ext transCheck  item e ba  of the t parent. 
BG Color Specifies the background color of the text. This field is available when Transparent is not 

ected.  sel
Direction Select one of the following directions to arrange the characters of the text. 

Direction From left to 
right 

From right to From top to 
bottom 

From bottom 
to topleft  

Input text: 
An 
example 

 

 

 
 

Position 

 

The position of the text body. 

 
The alignment of the text. 

Border Spacing The margin (in pixels) to the border of the object’s shape for the text body. 
Line Spacing The distance (in pixels) between two adjacent lines of the text. 
Character Spacing The distance (in pixels) between two adjacent characters of the text. 
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4.1.11. Drawing Picture Objects 

1.  In the Draw menu or Draw toolbar, click Picture . 

2.  Move the cursor onto the screen where you want to draw a picture object. A picture object w
display and move along with the c

ith default settings will 
ursor. 

ding box of the 

4.  Double-click t fine the settings for 
the picture o s of the picture 
object instantl

3.  Click the desired position on the screen to place the picture object. The upper-left corner of t
picture object will be at the clicked position. 

he boun

he picture object to bring up the Picture Object dialog box. Select a picture and de
bject in the dialog box. Note that you can use the Picture toolbar to modify the propertie

y. The following is an example of the Picture Object dialog box. 

 

following taThe ble describes each property in the Picture Object dialog box. 

Property Description 

Name 

The name of the picture that the object displays. You can use the drop-down list to select a 
picture from the picture database. 

Click  to select a picture from a file. After the selection, the software imports the picture 
of the selected file and saves the picture in the picture database. 

Click  to bring up the Select/Import from Library dialog box. Select a picture from a 
picture library file. After the selection, the software imports the selected picture from the 
selected library and saves the picture in the picture database. 

View Shows the processed result of the selected picture according to the current settings. 
Continued 
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Property Description 

Fit to Object atically to fit inside the Check this item so the picture can change its size autom
object. 

Transparent 
Check this item to make parts of the picture transparent. The transparent parts 

ransparent color. This 
 available when the picture is not a black and white picture. 

are pixels whose colors are identical to the specified t
item is

Transparent Color re is not a black The transparent color. This item is available when the pictu
and white picture. 

FG Color f a black and white picture. This item is The color to paint the black part o
available when the picture is a black and white picture. 

BG Color The color to paint the  of a black and white picture. This item is 
available when the picture is k and white picture. 

 white part
 a blac

Flip/Rotate Sp  picture before drawing it. There are 8 
op

ecifies the method to flip or rotate the
tions: 
Method Description 

0° Do nothing 
9 ees 0° Rotates the picture clockwise by 90 degr
1 picture clockwise by 180 degrees 80° Rotates the 
2 rees 70° Rotates the picture clockwise by 270 deg
X Flips the picture over the X axis 
90° & X Rotates the picture clockwise by 90 degree and flips it over the 

X axis 
Y Flips the picture over Y axis 
90° & Y Rotates the picture clockwise by 90 degree and flips it over the 

Y axis  
Tone Check this item to tone the picture. 
Toning r  Colo The color to tone the picture. 

Visibility 
ontrolled B

ption if the picture will be shown or hidden by the specified bit. 
C y Bit 

Check this o

Co
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ntrol Bit .  

Click 

Specifies the bit that shows or hides the picture object

 to enter the bit address. Click  to enter the bit tag. 

Visibilit
Control

Visible State Specifies the state (On or Off) that makes the picture visible. 

y 
 

Left The X coordinate of the upper-left corner of the object. 
Top The Y coordinate of the upper-left corner of the object. 
Width The width of the object. 
Height The height of the object. 

Profile 

Redraw Click this button to redraw the object on the screen with the current settings. 
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4.1.12. 

1 u or Draw toolbar, click Scale 

Drawing Scales 

.  In the Draw men . 

s will display and move 

 

4.  Dou ine the settings for th wing is an 
 to the right of the dialog bo

2.  Move the cursor onto the screen where you want to draw a scale. A scale with default setting
along with the cursor. 

3.  Click the desired position on the screen to place the scale. The upper-left corner of the bounding box of the scale
will be at the clicked position. 

ble-click the scale to bring up the Scale dialog box and then def
example of the Scale dialog box. The corresponding scale is shown

e scale. The follo
x. 
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The fo able describes each property in the Sca x. llowing t le dialog bo

Property Description 
Direction and Position ect the direction an ition of the scale.   Sel d the pos

Direction Horizontal Vertical 
Position Right Top Bottom Left 
Example 

 

 

Dynami
Range 

ers of the scale ticks and the range of the scale marks 
ic, i.e. to be by the specified variable. 

c Check this item if you want the numb
to be dynam  controlled 

Dynamic 
Range 

Parameter 
Block 

Specifies the variable the scale ticks and the range of the 
sc a ds). The following table 
describes the data mem

that controls the numbers of 
ale marks. The vari ble is an array of four double-words (8 wor

bers of the array. 
Word # Data Type Description 
0 sig  major ticks. The allowable range of 

this number is between 2 and 101. 
, 1 32-bit un ned integer The number of

2, 3 32-bit unsigned integer The number of divisions between two adjacent 
ge of this number is major ticks. The allowable ran

between 1 and 100. 
4, 5 32-bit s cale marks. igned integer The minimum of the s
6, 7 32 it s  marks. -b igned integer The maximum of the scale

 
Example 
Assume a scale’s dynamic range control block is $U100. The following macro commands 
makes the scale look like this:  
 

 
 

$U100 = 3 (UD) // The number of major ticks. 
$U102 = 5 (UD) // The number of sub-divisions. 

 = 0 (SD) // The minimum of the scale marks. 
 = 100 (SD) // The maximum of the scale marks. 

$U104
$U106

Color  the color, click the corresponding Color icon and select a The color of the scale. To specify
color from the Color palette. 

Number ic  minimum you can specify is two.  of Major T ks The number of major ticks. The
Number
Division

mum you can specify  of Sub 
s 

The number of divisions between two adjacent major ticks. The mini
is one.  

Minor Ti th ck Leng The length of minor ticks.  
Axis ve an axis. Check this item if you want the scale to ha

Marks Check this option if you want the scale to have marks. 
Font The font of the marks. 
Minimum The minimum of the marks. It is a 32-bit integer. 
Maximum The maximum of the marks. It is a 32-bit integer. 
Total Digits The total digits to be displayed for the marks. 
Fractional 
Digits 

The number of fractional digits for the marks. For example, when the Maximum is 5000, the 
Total Digits is 4, and the Fractional Digits is 2, the mark for the Maximum will be 50.00. 

Marks 

Reverse 
Order 

Check this option if you want the marks of the scale to show in reverse order. In normal 
order, the maximal mark is at the right end or top end of the scale. In reverse order, the 
maximal mark is at the left end or bottom end of the scale. 
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4.1.13. Drawing Tables 

1.  In the Draw menu or Draw toolbar, click Table . 

2.  Move the cursor onto the screen where you want to draw a table. A table with default setting
along

s will display and move 
 with the cursor. 

e will be at the clicked 

4.  into an empty cell of the table. If the object is allowed to be 
nfirm the operation. The following is an example of object 

3.  Click the desired position on the screen to place the table. The upper-left corner of the tabl
position. 

Use drag-and-drop editing to move an existing object
placed in the cell, a message box will pop-up to co
insertion with the confirmation dialog box. 

 
the object will be part
modifications such as mo

If you click Yes to insert the object to the table, 
 of the table. Any 

ving the table, resizing 
the table, deleting the table… will be applied to 
the objects of the table at the same time.  

 
 If you click No to cancel the operation, the 
object will move to the specified position and 
float over the table.

 
Note: Only 23 types of objects can be placed in the cells of the table. re Picture, Dot, Text, 
Bit Button, Toggle Switch, Wo eypad Button, Numeric 
Display, Numeric p, Time Display, Date 
D eek Disp pl , and Advanced Numeric 
D

5.  Click the cell inside the tabl

The supported objects a
on, Function Button, K

isplay, GIF Dis ay

rd Button, Multistate Switch, Screen Butt
 Entry, ASCII String Display, ASCII String Entry, Bit Lamp, Multistate Lam

lay, Message Display, Bar Graph, Picture D

e. If the cell contains the object, there will be

isplay, Day-of-W
isplay. 

 the  icon on th
 the table. 

e upper-left corner of the 
cell. The following is an example showing you how to edit the object in

 
 

a
 Left-click the icon 
nd hold down the 

button. When the 
cursor changes to , 

This is an empty 
cell where you 
can place an 
object. 

move the object out of 
the table.  
 

 Double click the icon 
to bring up the 
properties dialog box 
of the corresponding 
object and then define 
the settings of object 
for the selected cell. 
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6  When the cursor changes to . Position the mouse point over one of the grid lines.  or , drag the line until the 
column is the width and the row is the height you want.  

Drag the line to adjust the 
width of the column. 

Drag the line to adjust the 
height of the row. 

 

elected in the general 
height of the row when the Distribute Rows Evenly is not 

 the general page of the Table dialog box. 

7 ck anywhere inside the table, other than the 

Note: You can adjust the width of the column when the Distribute Columns Evenly is not s
f the Table dialog box. And you can adjust the page o

selected in

. Double-cli  icon, to bring up the Table dialog box and then define the 
s ox contains the following two pages: 

  
■   General 

Described in Section 4.1.13.1

ettings for the table. This dialog b

. 
■   Cell 

Described in Section 4.1.13.2. 

 

CHAPTER 4   DESIGNING SCREENS



4  
 

 

 
4-30CHAPTER 4   DESIGNING SCREENS  

 

This section describes ho g is an example of the General 
page of the Table Object di

4.1.13.1. General Settings 
w to define the general settings for the table objects. The followin
alog box. 

 
bes each p erty in the General pagThe following table descri rop e of the Table dialog box. 

Property Description 
ID rated when the object is created and is unchangeable. 

ted. The format of the 
The object’s identifier is gene
The identifier is unique within the screen where the object is loca

 IDs for the tables is TBLnnnn.
Note You can type a note for the object. 
Shape ing up the Shape of an  settings For details about the following properties, see Section 4.3.4 Sett

Object. , Border Color, BG Color 
Number of rows Specifies the number of rows in the table. 
Number of colu f columns in the table. mns Specifies the number o
Distribute rows 
evenly 

Check this option if you want the rows of the table to be always distributed evenly. 
Uncheck this option if you want to adjust the heights of the rows. 

Distribute columns 
evenly 

Check this option if you want the columns of the table to be always distributed evenly. 
Uncheck this option if you want to adjust the widths of the columns. 

Cell 

Drag and drop Check this option so you can drag and drop an object into a cell of the table. Note that 
not all kinds of objects can be placed in the cells of the table. 

Vertical Check this option if you want the table to have vertical grid lines. 
Horizontal Check this option if you want the table to have horizontal grid lines. 
Style Specifies the style for the grid lines. 

Grid 

Color Specifies the color for the grid lines.  
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able Object dialog box and  

4.1.13.2. Cell Settings 
The following is an example of the Cell page of the T
Insert Button is clicked. 

 the Select Object Dialog box when the
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The following t ake the buttons available, you 
o select 

able describes each property in the Cell page of the Table dialog box. To m
need t a row. To select a row, left-click the (Row, Column) column. 

Property Description 
(Row,Column) The location of the cell. 
Object nserted and it is called 

cell. 
The type of the specified object. If the field is empty, the cell has no object i
empty 

 
Click the button to bring up the properties dialog box of the specified object and define the settings 

t field is not empty. of the object for the selected cell. The button is available when the Objec
Margin  the cell border. Select a number between 0 The distance in pixels between the object boundary and

and 10. 
Delete Click the button to clear the contents of the selected cell. The button is available when the selected 

cell is not empty. 
Insert Click the button to bring up the Select Object dialog box shown above. Select an object type listed 

in the dialog to create a new object for the selected cell. The button is available when the selected 
cell is empty. 
 
Note: The table won’t allow the insertion of the type of object which is not listed in the dialog. 

Move Up Click the button to move the selected cell before the previous cell. It will not be available when 
multiple rows are selected, no row is selected, or the first row is selected. 

Move Down Click the button to move the selected cell after the next cell. It will not be available when multiple 
rows are selected, no row is selected, or the last row is selected. 

Click the button to bring up 
the Select Object dialog. 
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4.2. Editing Objects 

cts first and then move around, copy, or edit the selections without 

To select an object, move the mouse to the object you want to select and then click the left button.  

enu.  

become one of 
ctangular selection area. Then drag the mouse diagonally. Release the mouse button when you reach 

 be.  
 

aped tabs around it. The object with solid tabs is the reference object. 

with the Selected Area 

anges to 

In this section you will learn how to select the obje
affecting the rest of the screen. 

4.2.1. Selecting and De-selecting Objects 
■ Selecting Objects 

To add an object to the selection, use Shift + Click.  
To select all objects of the active screen, use Ctrl + A, or use the Select All command on the Edit m
 
■ Selecting Objects by a Rectangular Area 
Left-click on the blank area of the screen, and hold the button to begin your selection. Where you click will 
the corners of the re
the position that you want the opposite corner of the rectangular area to

Each of the selected objects will have blue square-sh
 
■ De-selecting Objects 
To de-select objects, either click the blank area of the screen, or make a new selection.  

4.2.2. Basic Operations 
■ Moving Objects 

Left-click anywhere inside the selected object and hold down the button. When the cursor turns ch , drag the 
n will "float" over the rest of the screen, allowing 

you to position it wherever you like. Rel he mouse button to "let go" of the selection.  

■ Grouping or Ungrouping Objects 

mouse to move the selection to another area of the screen. The selectio
ease t

 

To group the selection, click  on the edit toolbar, or use the Group command on the Edit menu 
menu. After you have grouped a selection that includes at least two objects, you can copy, move o
group as  single unit. Y u can select an object within the group and change its properties withou
also save the group to the object library and use this object group in an animated graphic. 

or on the object pop-up 
r resize all objects in a 

a o t ungrouping. You can 

To ungroup the selected group, click  on the edit toolbar, or use the Ungroup command on the Edit menu or on the 
object pop-up menu. After ungrouping the objects, the objects within the group will be restored to the single ones. 

 

re-shaped tabs located 
at down. When the cursor 
changes to 

■ Resizing Objects 
The square-shaped tabs around your object can be re-sized. You can resize by clicking on the squa

the corners and the middle sections of the bound rectangle area and holding the mouse button 
 or  or  or , drag the mouse to change the size of the selection. Release the mouse button when 

the selection is the size you like. You can make it bigger or smaller, and achieve a distorted effect by "squashing" or 
"stretching" the selection to make it either wider/narrower or taller/shorter than its original proportions. 
Tip: You can’t resize more than one object at a time unless you group multiple objects before resizing. 
 
■ Auto Text Resizing 

To automatically scale the text of the object when resizing the object, click  on the edit toolbar if it is raised, or use the 
Auto Text Resizing command on the Edit menu.  
Tip: The Auto Text Resizing command is checked and the icon is sunken by default. If you don’t want to resize the text 

when resizing the object, you need to uncheck the Auto Text Resizing command or click the sunken icon to make the 
font size fixed. 



4 4  
 

 

 
4-33 

 
■ Pinning or Unpinning Objects 

To pin the selection so that it cannot move, click  on the edit toolbar, or use the Pin command on the Edit menu or on 

 can move again, click 

the object pop-up menu.  

To unpin the selection so that it  on the edit toolbar, or use the Unpin command on the Edit 

d. 

and plac Windows™ clipboard, press Ctrl+C, or click 

menu or on the object pop-up menu. 
Tip: Pinned objects can still be resize
 
■ Copying or Cutting and Pasting Objects 

To copy a selection from the current screen e it on the  on the 
on the obje

click 

standard toolbar, or use the Copy command on the Edit menu or ct pop-up menu.  

To cut a selection from the screen, press Ctrl+X, or  on the standard to bar, or use the Cut command on the 

ing Ctrl+V, or click 

ol
Edit menu or on the object pop-up menu.  

After Copying or Cutting, you can paste the selection by press  on the standard toolbar, or use the 
on the object pop-up menu.  Paste command on the Edit menu or 
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ste are good for moving objects around within the screen or to another screen. 

By pasting multiple times on the current screen, you can achieve a cascading effect.  
y pasting once to a different screen, the position of the pasted object will be the same as the copied object from the 

selection, press Del, or use the Delete command on the Edit menu, or on the object pop-up menu. When you 
r is in the selection will be deleted. 

 
■
To n, pre +Z, or use the Undo comm
 

s that were p and, press Ctrl+Z, or use the Redo command on 
e

 Keyboard Shortcuts  

Tip: Cut and Pa
Copy and Paste are good for duplicating objects from the current screen to other screens.  

B
original screen. 

 

■ Deleting Objects 
To delete a 
use Delete, whateve

 Undo 
 reverse the last actio ss Ctrl and on the Edit menu. 

■ Redo 
To reapply the action reviously canceled by the Undo comm
the Edit m nu. 
 
■

Shortcut Operation Shortcut Operation Shortcut Operation 
【Ctrl+N】 New Project 【Ctrl+X】 Cut 【Ctrl+D】 Duplicate 

【Ctrl+O】 Open Project 【Ctrl+C】 Copy 【Ctrl+F】 Find 

【Ctrl+S】 Save 【Ctrl+V】 Paste 【Ctrl+R】 Replace 

【Ctrl+Z】 Undo 【Ctrl+Click+move】 Copy & Paste 【Ctrl+A】 Select All 

【Ctrl+Y】 Redo 【Del】 Delete 【Shift+Click】 Multiple Select 

    【Ctrl+Click】 Reference Object Select 

 

To
an rso

 copy and paste the selection by mouse, press and hold down the Ctrl key,
d then left-click the selection and hold down the button. When the cu r

changes to , drag the mouse to copy the selection to another area of the
n. The picture oscree n the right is an example. 
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and on  
pop-up and allo

4.2.3. Duplicating Objects 
To duplicate the selected object, use the Duplicate… comm
duplicate command is executed, the following dialog will 
 

the Edit menu or on the object pop-up menu. After the
w you to set how to duplicate objects.  

 

 
 

ble de

 

The following ta scribes each property in the Duplicate dialog. 

Property

Preview 
addresses 

Click View > Address > Monitor on the 
menu to show the monitor address on the 

object. upper-left corner of the 

 Description 
Columns The total number of columns. Num

of Cop
ber 

ies Rows  rows. The total number of
V rtica  direction. e l The distance (in pixels) between two adjacent objects in the verticalSpacing 

in Pixels Horizon ction. tal The distance (in pixels) between two adjacent objects in the horizontal dire
Increase Addres  a specified increment s Check this item so the address of each duplicate will be increased to

over the previous object. 
Increment The increase amount. 

 
From top to bottom, place the duplicates row by row. In the same row
the right of the previous object. 

, place the duplicate to 

 
From top to bottom, place the duplicates row by row. In the same row
the left of the previous o

Copy 
Direction 

, place the duplicate to 
bject. 

 
From bottom to top, place the duplicates row by row. In the same row
the right of the previous

, place the duplicate to 
 object. 

 
From bottom to top, place the duplicates row by row. In the same row, place the duplicate to 
the left of the previous object. 

 
From left to right, place the duplicates column by column. In the same column, place the 
duplicate below the previous object. 

 
From right to left, place the duplicates column by column. In the same column, place the 
duplicate below the previous object. 

 
From left to right, place the duplicates column by column. In the same column, place the 
duplicate above the previous object. 

 
From right to left, place the duplicates column by column. In the same column, place the 
duplicate above the previous object. 
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n, you need to select a reference object from within the selection and then press 
ift + Click. To select a 

4.2.4. Aligning Objects 
To arrange the selected objects on a scree
the icon on the toolbar or click the menu item listed as below. To do a multiple selection, use Sh
reference object from the selection, use Ctrl + Click. 

Use the Align commands on the Edit menu to arrange objects/drawings on a screen. Select an object or drawing by 
e-clickin hold down the Shift key while cli r objects or drawings to be aligned with it. When 

he o rawings to be aligned are selected s in the Align submenu or directly 
click a specified n in the

singl
all of

g on it, then 
bjects or d

cking on the othe
, choose one of the command t

 ico  Edit Toolbar. 

Icon Menu Item Description  

 Left 
ference object. All the 

lly so their left sides are in line with the left side of the 
Align the left sides of selected objects to the left side of the re
objects move horizonta
reference object. 

 
Vertic
Cente

enter of the reference 
are in line with the al Align the vertical centers of selected objects to the vertical c

r object. All the objects move horizontally so their vertical centers 
vertical center of the reference object. 

 Right 
ference object. All the 
 the right side of the 

Align the right sides of selected objects to the right side of the re
objects move horizontally so their right sides are in line with
reference object. 

 Top object. All the objects 
move vertically so their tops are in line with the top of the reference object. 
Align the tops of the selected objects to the top of the reference 

 
Horizo
Cente

objects to the horizontal center of the 
ntal centers are in line ntal Align the horizontal centers of selected 

r reference object. All the objects move vertically so their horizo
with the horizontal center of the reference object. 

 Bottom
ference object. All the 

m of the reference  
Align the bottoms of selected objects to the bottom of the re
objects move vertically so their bottoms are in line with the botto
object. 

 

Align 

To Grid Select or deselect the option of aligning objects to grid points. 

 Left tion is selected, each 
r aligns to the nearest 

Nudge the selection left. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel left. When the Snap to Grid op
object of the selection moves left to where its upper-left corne
grid point. 

 Right 

selected, all objects of 
tion is selected, each 

object of the selection moves right to where its upper-left corner aligns to the nearest 
grid point. 

Nudge the selection right. When the Snap to Grid option is not 
the selection move one pixel right. When the Snap to Grid op

 Up 

Nudge the selection up. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel up. When the Snap to Grid option is selected, each 
object of the selection moves up to where its upper-left corner aligns to the nearest 
grid point. 

 

Nudge 

Down 

Nudge the selection down. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel down. When the Snap to Grid option is selected, each 
object of the selection moves down to where its upper-left corner aligns to the nearest 
grid point. 
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bjects in the selection the same size as the refer  by first selecting the objects using Ctrl + Click, press 
n r or click the menu item listed below

4.2.5. Making Objects Same Size 
Make o
the icon o

ence object
.   the toolba

Icon Menu Item Description 

 Width Make the selected objects have the same width as the reference object. 

 Height Make the selected objects have the same height as the reference object. 
Make 
Same 
Size 

he selected objects have the same width and height as the reference object.  Both Make t
 

 

4.2.6. Arranging the Order of Objects 
Icon Menu Item Description  

 Bring to To to the top. p Bring the selection 

 Bring Forward Bring the selected object one layer up. 

Send Backward Send the selected object one layer down.  

 Send to Bottom Send the selection to the bottom. 

Layer 

 Set Order Start the order setting process for the objects of the activ
please see Section 4.2.6.1 Changing the Order of Objects

e screen. For details, 
 

 

4.2.6.1. Changing the Order of Objects 
The object order in the software is the order in which the selection cursor moves the input focus from one object to the 

screen. Usually the order proceeds from left to right and from top to bottom in a screen. In the model with 
ves input focus in the specified order by clicking 

direction keys. In a touch panel, you can use the function button to select a data entry object with the order number 
ction. 

pping objects, changing the order will change the 
top of any overlapping 

■ Viewing order 
To view the current order of all objects in the screen, click Set Order on the Edit menu. 
 
■ Changing order 
To change the order for all objects in the screen 
1) On the Edit menu, click Set Order 

A Number in the upper-left corner of each object shows its place in the current order 
2) Set the order by clicking each object in the order that you want the objects to be displayed. The ordering number 

starts from 1. 
3) Click the blank field on the screen to exit Set Order mode 

next within a 
programmable keys such as 037-LSK, the Data Entry Object recei

previous or next to the current sele
 
The object order is also the display order. If the screen contains overla
display sequence of the objects. The objects that come later in the order are always displayed on 
objects that precede them in the order. 
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The following is an example of the object ordering. 

   
 
If the screen is running on 037-LSK, click the down or right direction key to move the selection in 2-4-6-8-10-12-14-16-18 

-20-29 sequence. If the screen is running on the touch panel, click the function button  to move the selection in the 
same sequence. The text objects with 1,3,5…order number are not data entry object, so they won’t receive the selection 
and are not listed in the sequence. 
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4.3. Designing Object Appearance 

n g table: There are four commo  components of object appeara re described in the followinnce. They a

nent Description Appearance Compo
Shape  or a picture shape. The shape of an object can either be a graphical shape

The following are examples of graphical shapes 

 
The following are examples of picture shapes. 

 
m. For details, see The software provides many graphical shapes for you to choose fro

Section 4.3.3 Selecting a Graphical Shape. The color or the pattern
dependent on the state of the associated object. You need to spec
settings of a graphical shape for each state of the associated objec

 of a graphical shape is 
ify the color or pattern 
t. For details, see 

Section 4.3.1 Selecting a Color and Section 4.3.2 Selecting a Pattern. 

ct to have a picture shape, check the item Picture Shape in the General 
ture from the picture 

bject. Any picture with 
picture is used as a 

bject) states. If 
ction, you 

re groups, please see 

 
If you want an obje
Page of the object’s property dialog box. You can select a pic
database or import a picture from a library file for the shape of an o
the format of BMP, JPG, or WMF can be a picture shape. When a 
shape, the shape is state independent, i.e. the same look appears for all (o
you want a picture shape to display the object state and/or show the touch a
need to select a picture group as the shape. For details of pictu
Section 2.2.3.2 Picture Groups 
 
To know how to set a shape, se 3.4 Setting up the Shape of an Objecte Section 4. . 

Inner Label n inner la me number of states as 
the associ the picture settings of an 
inner label for each (obje endent. You need to 

cify the s well. Note that not all objects can 
ner label. 

ings.

A bel is a label inside the associated object. It has the sa
ated object. You need to specify the text settings and 

ct) state. Inner labels are language dep
spe  text of an inner label for each language a
have inner labels and some objects can have just text or a picture as their in
To know how to set an inner label, see Section 4.3.5 Label Sett  

VFTA (Visual Feedbac
Touch Action) 

feedbacks when it is k for A button or switch can give the operator one of the following visual 
touched: 

Visual Feedback Description 
Sunken Shifts the inner label to the lower-right corner by one or two pixels.
Back Fills the area inside the border of the shape with the shape’s FG 

Color. 
Outline Outlines the object with the shape’s FG Color.  

External Label An external label is a label outside of but still attached to the associated object. Unlike 
inner labels, external labels are state independent. They have the same look for all 
(object) states. However, external labels are language dependent. You need to set the 
text of an external label for each language. External labels are touch insensitive. Touching 
an external label will not activate the associated object. Note that not all objects can have 
an external label. 
To know how to set an external label, see Section 4.3.8 External Label Settings. 
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The following table shows the common appearan ponents th ject type ca
 

ce com at each ob n have: 

CHAPTER 4   DESIGNING SCREENS

ape Inner LabelSh  
Object Types Graphical

Shape 
Picture 
Shape Text Pic

External VFTA Label ture 

Bit Button, Toggle Switch, Screen Button, Word 
ulti-state Switch, Radio Button Grou  ●  ● ● ● Button, M p ● ●

Function Button, Keypad Button, Page Select  ●  ● ●  or ● ●
Step Button ●  ● ● ● ● 
Bit Lamp, Multi-state Lamp,   ●  ●  ● ● ●
Message Display      ● ● ●
Picture Display ●   ●  ● 
Day-of-week Display ●  ●    
Meter ● ●     
Slide Switch, Numeric Entry, Numeric 
Advanced Numeric Display, ASCII

Display, 
 Character 

haracter Display, Bar Graph 
●     ● 

Entry, ASCII C
Time Display, Date Display, Pie Graph, Line Chart, 

lay, ric Trend Graph, Single Record Line 
Chart, Operation Log Display, Recipe Selector, 
Recipe Table, Sub-link Table, Static Text, Table 

     
Scatter Chart, Alarm Display, Historic Data 
Disp  Histo ● 

Anim raphic    ated G    ●
 
T  o ing the comm mpo re  examples: he rders of draw on appearance co nents a shown in the following table with
Step Draw Example 1 Example 2 Description 

  1 Shape 
A picture gr up that supports 
the pres

A graphical sh
SW_0023 

Described in Section 4.3.4 
o

sed look 
ape named 

2 Picture of Inne
label 

r 
 

(None) Described in Section 4.3.5.2

3 Text of inne
label 

r 
 Described in Section 4.3.5.1 

4 VFTA (None) Back (FG Col )  or is 

(None) 
 

5 External label Described in Section 4.3.8 

 

  

Final Appearance 
(When untouched) 

Final Appearance 
(When touched)   
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lecting a Color 

that requires a color. It shows the color of the current selection 
and you can click it to bring up the Color palette. With the Color palette, you can select a color for the associated property. 
The following is a Color icon showing that the current selection is yellow. 

4.3.1. Se
■ Color Icons 
In a dialog box, a color icon is associated with a property 

 
 
■ Color Palette 

Select a color from a set of use
 
Usually, you click a Color i

With the Color palette, you can: 1) Select a color from a set of predefined colors, 2) Customize a set of user colo

ows the pages of the Color pal

rs, and 3) 

ette. 

r colors. 

con to bring up the Color palette. The following sh

     
 To select a color, click on that color block. 

n any position other than the color blocks 
ntains the user colors. To customize user 

  

On page 1, the yellow block is outlined to indicate that it is the current selection.
To select a page, click on that page’s number tab. To cancel the operation click o
and the number tabs. Page 1, 2, and 3 contain the predefined colors. Page 4 co
colors, click  to bring up the Define Custom Color dialog box as shown below. 
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cting a Pattern 

. It shows the pattern of the current 
sele ion and you can click it to bring up the Pattern palette. With the Pattern palette, you can select a pattern for the 
asso roperty. The following is a Pattern icon showing that the current selection is the “big dashes”. 

4.3.2. Sele
■ Pattern Icons 
In a dialog box, a Pattern icon is associated with a property that requires a pattern

ct
ciated p

 
 
■ Pattern Palette 
With the Pattern palette, you can select a pattern from a set of predefined patterns. Usually, you click a Pattern icon to 
bring up the Pattern palette as shown below. 

 
The “big dashes” block is outlined to indicate that it is the current lect a pattern, click on that pattern block. 

cting a Graphical Shape 

selection. To se
To cancel the operation, click on any position other than the pattern blocks. 
 

4.3.3. Sele
■ Shape Buttons 

In an object’s property dialog box, you can click the shape button  to bring u  the Shape palett
palette, you can sel

p e. With the Shape 
ect a graphical shape as the shape of the associated object. 

pe palette, you can select a graphical shape for an object. Usually, you click 

 
■ Shape Palette 

With the Sha  to bring up the Shape 
palette. The Shape palette contains several pages of graphical shapes. To select a graphical shape, click on that graphical 
shape. To select a page, click on that page’s number tab. To cancel the operation, click the close button  to close the 
Shape palette. 
 
There are four sets of graphical shapes available for your applications. Each of them is suitable for certain kinds of objects. 
The Shape palette shows the set that is suitable for the type of object concerned. The four sets of shapes are shown 
below. 
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witGraphical shapes for buttons and s ches 

      

    

Graphical shapes for data entry objects 
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 Graphical shapes for data display objects
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Graphical shapes for lamps 
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Object 

ive the operator visual feedback for the touch action, most of the graphical shapes designed for touch operable 
objects can change their look when touched. The edge or border can look pressed or the outline can be shown with a 

 

4.3.4. Setting up the Shape of an 
This section describes how to set the shape of an object. 
In order to g

different color. 

The following examples are the shape settings of a bit button: 
Example 1 Example 2 

The graphical shape SW_0031 is selected. The graphical shape is a picture. 

 

 
ng ired for the settings of an object’s shape. The followi table describes each property that may be requ

Property Description 
ap graphical shape. This e Check this option if you want the object to have a picture shape instead of a 

option is available when the object can have a picture shape. 
Picture Sh

 
ape is checked, the 

ect/Import from Library dialog box will display. Otherwise, the Shape palette will display. 
Click this button to specify the shape of the object. When Picture Sh
Sel

VFTA  The type of VFTA (Visual Feedback for Touch Action). 
Test VFTA w the selected VFTA. Click this button to vie
Border Color rder color of the graphical shap he corresponding Color icon to specify the color. The bo e. Click t
Pattern The pattern that is used to fill the area inside the border of the graphical shape for the current 

(object) state. To specify the pattern, click the corresponding Pattern icon and select a pattern from 
the Pattern palette. This item is available when the area inside the graphical shape needs be 
painted. 

FG Color 
d 

The color that is used to paint the black part of the pattern for the current (o
solid white pattern is selected, this color is not used. When a pi

bject) state. When the 
cture shape is used, this color is use

for the outline mode with VFTA. 
Example 1 Example 2 

  
To specify the color, click the corresponding Color icon and select a color from the Color palette. 
This item is available when the area inside the graphical shape needs be painted. 

BG Color The color that is used to paint the white part of the pattern for the current object state. To specify the 
color, click the corresponding Color icon and select a color from the Color palette. This item is 
available when the area inside the graphical shape needs be painted. 
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This section describes how to set up the inner label for the following types of objects: 
it Lamp. 

T e ove mentioned objects provide you with the Label page to set up the inner label. If an object 
 age has the Text sub-page and the Picture sub-page for you to set up the text and the 

 he tively. If an object has two states, the Label page has the following four sub-pages: 

4.3.5. Label Settings 

Bit Button, Toggle Switch, Screen Button, Function Button, Word Button, Keypad Button, and B
 

he property she ts of the ab
, the Labeonly has one

picture of
state l p
inner label respect

Sub-page For Setting 
OFF Text  (Off) Text of state 0
OFF Picture Picture of state 0 (Off) 
ON Text Text of state 1 (On) 
ON Picture Picture of state 1 (On) 

 
You can use the Label page to set the inner label of an object that can have at most two states.  
The following is an example of the Label page. 
 

T  only the properties in 
th mmon to all its sub-pages. 
T sub-pages are described 
in ge. 

he following table describes
e Label page that are co
he properties of each of its 
 the specific section about each sub-pa

Property Description 

L age that you are setting 
the text for. anguage The langu

Border Spacing
n (in pixels) to the 

border of the object’s shape for 
e text body and picture. 

The margi

both th
Use the text 
th
la
o
la

m so the inner label 

regardless of what the 
guage is. 

of 
e first 

Check this ite
always shows the text of the first 

nguage for all 
ther 

language 
current lan

nguages 

T Click this tab to bring up the Text 
 ext tab sub-page.

Picture tab Click this tab to bring up the 
Picture sub-page. 

OFF Text tab Click this tab to bring up the OFF 
Text sub-page. 

ON Text tab Click this tab to bring up the ON 
Text sub-page. 

OFF Picture 
tab 

Click this tab to bring up the OFF 
Picture sub-page. 

ON Picture tab Click this tab to bring up the ON 
Picture sub-page.  
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se the Text sub-page, OFF Text sub-page, and ON Text sub-page to set up the text of the inner label for each of 
the corresponding states, as well as the current language. The language being set is specified by the Language item in the 

4.3.5.1. Text Sub-page Settings 
You can u

Label page.  
 
The following are examples of the Text pages:  

Text sub-page ON Text sub-page 

 

The following tab -page. le describes each property in the Text sub-page, OFF Text sub-page, and ON Text sub

Property Description 
Copy from Note al page.  Click this button to replace the current text by the text of Note in the Gener
Copy to ON State Click this button to use the current text to replace the text of ON state. 
Copy to OFF text of OFF state. 
State 

Click this button to use the current text to replace the 

Font The font of the text. You can use the drop-down list to select a fon

Click 

t.  

 to bring up the Font Templates dialog box and select a font for the text. You can 
change the font templates before selecting a font in that dialog box. 

Color The color of the text. To specify the color, click the corresponding Color icon and select a color 
from the Color palette. 

Blink Check this item so the text will blink. You have blink effects to choose from. Color switching 
changes the color of the text from its original color to the color of the background. Text On/Off 
displays and hides the text. 

Transparent Check this item to make the background of the characters transparent. 
BG Color The background color of the text. 

Continued
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Property Description 

Line Spacing  of the text. The distance (in pixels) between two adjacent lines
Character 
Spacing 

The distance (in pixels) between two adjacent characters of the text. 

 
The alignment of the text. 

Position 

 

The position of the text body. 

lor The BG color of the object’s shape for the current state. Shape BG Co
Copy Attributes to Click this button to use the current attributes to replace the text of ON state. 
ON State 
Copy Attributes to 
OFF State 

Click this button to use the current attributes to replace the text of OFF state. 

 

4.3.5.2. Pictu ettings 
You can use the Picture sub-page, OFF Picture sub-page, and ON Picture sub-page to set up the picture of the inner label 

 

re Sub-page S

for the corresponding states.  

The following are examples of the Picture pages: 

Picture sub-page ON Picture sub-page. 
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T  table describes each property in the page, OFF Picture sub-page, and ON Picture sub-page. 
 

he following  Picture sub-

Property Description 
Name he picture database.

Cl

The name of the picture. You can use the drop-down list to select a picture from t

ick  to select a picture file. After the selection, the picture of the select
saved in the picture database. 

ed file is imported and 

Click  to bring up the Select/Import from Library dialog box. Select a picture from a picture library 
n the picture database. file. After the selection, the selected picture is imported and saved i

Copy to OFF 
State Click this button to use the current picture to replace the picture of OFF state. 

Copy to ON  to use the current picture to replace the picture of ON state. State Click this button

Transparent arts are pixels whose 
e as the specified transparent color. This item is available when the picture is not a 

 Check this item to make parts of the picture transparent. The transparent p
colors are the sam
black and white picture. 

T. Color The transparent color. 
FG Color color to paint the black ck and white picture. This item is available when the picture is 

a blac  picture. 
The part of a bla

k and white
BG Color The co nd white picture. This item is available when the picture is 

 blac
lor to paint the white part of a black a

a k and white picture. 
Flip/Rotate pecif re before drawing it. There are 8 options: S ies the method to flip or rotate the pictu

Method Description 
0° No rotation 
90°  clockwise by 90 degrees Rotates the picture
180° Rotates the picture clockwise by 180 degrees 
270° Rotates the picture clockwise by 270 degrees 
X Flips the pi cture over the X axis 
90° & X Rotates the picture clockwise by 90 degrees and flips it over the

X Axis 
 

Y Flips the picture over the Y axis 
90° & Y Rotates the pictur

 
e clockwise by 90 degrees and flips it over the 

Y Axis 

Tone Check this item to tone the picture. 
Toning Color The color to tone the picture. 

t Check this item so the picture can change its size automatically to fit inside the border of the object’s 
shape. 

Fit to Objec

Position 

 

The position of the picture within the object. 

Shape BG 
Color The BG color of the object’s shape for the current state. 
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Th

Page Selector, Multi-state Lamp, Message Display, and 

u with the Text page to set up the text of the inner label. 

4.3.6. Text Settings 
is section describes how to set up the text of the inner label for the following types of objects: 

Multi-state Switch, Radio Button Group, Step Button, 

The property sheets of the above mentioned objects provide yo
The following is an example of the Text page. 

Day-of-week Display. 
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ing table dThe follow escribes each property in the Text page. 

Property Description 
Language The language that you are setting the text to. 
Border Spacing The margin (in pixels) of the border for the text body to the object’s shape. 
Use the text of the 
first language for all 
other languages 

Check this item so the inner label always shows the text of the first language regardless of 
what the current language is. 

<State list> Lists all states and the corresponding texts. To view and modify the state attribute and its text, 
click the row of that state. 

Move Up Click this button to move the current text (and picture) up the list, and thus the associated 
state number of the current text (and picture) is decreased by one. 

Move Down Click this button to move the current text (and picture) down the list, and thus the associated 
state number of the current text (and picture) is increased by one. 

Continued

You can view the texts and the picture names of all 
the states here. You can select a state from the list. 

selected state becomes the current The text of the 
text.

The text of the current state and 
language. You can view and edit 

e. the current text her
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Property Description 

Copy to all states… e the text of all other states.  Click this button to use the text of state 0 to replac
Copy from state 0… nt text.  Click this button to use the text of state 0 to replace the curre
Font  The font of the current text. You can use the drop-down list to select a font. 

Click  to bring up the Font Templates dialog box and select a font for the current text. 
cting a font from the dialog box. You can change the font templates before sele

Color The color of the curre
select a color from the Col

nt text. To specify the color, click the corresponding Color icon and 
or palette. 

Transparent  to make the text’s background transparent. Check this item
BG Color The background color of the text. 

 
The alignment of the text. 

Position 

 

The position of the text body. 

Blink S ges the color of the text from 
nd hides the text. 

elect blink effects to make the text blink. Color switching chan
its original color to the color of the background. Text On/Off displays a

Shape BG Color rent state. The BG color of the object’s shape for the cur
<Edit Box> / The text for the selected state in current language.<Combo Box>  Text 

 /  Click  to view and edit the text for the selected language in this edit box, or click  to 
select a text from dropdown text table that lists all the texts from Text Database. You can 
change the text database before selecting a text.  

Line Spacing The distance (in pixels) between two adjacent lines of the text. 
Character Spacing The distance (in pixels) between two adjacent characters of the text. 
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Th

Multi-state Switch, Radio Button Group, Step Button, Page Selector, Multi-state Lamp, Picture Display, and Animated 

 

4.3.7. Picture Settings 
is section describes how to define the picture settings for the following types of objects: 

Graphic. 
 
The property sheets of the above mentioned objects provide you the Picture page to define the picture settings of the
objects. The following is an example of the Picture page. 

 
The following table describes each property in the Picture page. 

CHAPTER 4   DESIGNING SCREENS

Property Description 
Picture The name of the current picture. You can use the drop-down list to select a picture from the picture 

database. 
Click  to select a picture from a file as the current picture. After the selection, the software imports 
the picture of the selected file and saves the picture in the picture database. 
Click  to bring up the Select/Import from Library dialog box. Select a picture from a picture library 
file as the current picture. After the selection, the software imports the selected picture from the 
selected library and saves the picture in the picture database. 

  Continued
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Property Description 

Transparent arent parts are pixels 
are identical to the specified transparent color. This item is available when the current 

picture is not a black and white picture. 

Check this item to make parts of the current picture transparent. The transp
whose colors 

Transparent 
Color 

The transparent color. 

FG Color en the current The color to paint the black part of a black and white picture. This item is available wh
picture is a black and white picture. 

BG Color  co  the white part of a black and white picture. This item is available when the current 
picture  and white picture. 
The lor to paint

 is a black
Flip/Rotate Specif rent picture before drawing it. There are 8 options: ies the method to flip or rotate the cur

od Description Meth
0° No rotation 
90° Rotates the picture clockwise by 90 degrees 
180° Rotates the picture clockwise by 180 degrees  
270° Rotates the picture clockwise by 270 degrees 
X Flips the picture over the X axis 

90° & X Rotates the picture clockwise by 90 degrees and flips it over the X 
Axis 

Y Flips the picture over the Y axis 

90° & Y Axis 
Rotates the picture clockwise by 90 degrees and flips it over the Y 

 

Tone Check this item to tone the current picture. 
Toning Color The color to tone the current picture. 
Fit to Object ge its size automatically to fit inside the border of the 

object’s shape. 
Check this item so the current picture can chan

Position 

 

The position of the current picture within the object. 

Shape BG 
Color 

The BG color of the object’s shape for the current state. 
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Th

rd Button, Multi-state Switch, Radio Button Group, Step 
Button, Numeric Entry, Numeric Display, Advanced Numeric Display, ASCII String Entry, ASCII String Display, Bit 

You can use the External  of that object. The following 
is an example of the External Lab

 

4.3.8. External Label Settings 
is section describes how to set up the external label for the following types of objects: 

Bit Button, Toggle Switch, Screen Button, Slide Switch, Wo

Lamp, Multi-state Lamp, Message Display, Picture Display, and Bar Graph. 
 

Label page of an object's property sheet to set up the external label
el page. 

 
 

The following table describes ea roperty in the External Lch p abel page. 
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Property Description 
Plate Style Specifies the ere are four plate types as shown 

below: 
 plate type of the external label. Th

Plate Type Example 

 
Transparent, 

Flat, 
 

Outlined 
 

Raised 
  

Continued 
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Property Description 
Position pecif osition of the external label relative to the object. There are four 

ositio w
S
p

ies the p
ns as sho n below: 
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Position Example 

 

Top 

 
Left 

Right 
 

Bottom 

  

Border cify the color, click the corresponding Color icon 
lor palette. 

The border color of the plate. To spe
and select a color from the oC

Plate onding Color icon and The color of the plate. To specify the color, click the corresp
select a color from the Color palette. 

Color 

Text The color of the tex
select a color from the Col

t. To specify the color, click the corresponding Color icon and 
or palette. 

Language The language that you are setting the text to. 
<Drop-down List> The font of the text for the current language Font 

 
on to bring up the Font Templates dialog box and select a font for the 

nge the font templates before selecting a font in that dialog box. 
Click this butt
text. You can cha

<
<Combo Box

Edit Box> / 
> The text for the current language. Text 

 /  Click  to view and edit the text for the selected language in this edit box, or click 

 to select a text from dropdown text table that lists all the texts from Text 
Database. You can change the text database before selecting a text.  

 The alignment of the text. 

Border The distance (in pixels) between the plate border and the text body. 
Line The distance (in pixels) between two adjacent lines of the text. 

Spacing 

Character The distance (in pixels) between two adjacent characters of the text. 
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4.4. Setting up Objects 

ng states. You need 
to specify the settings of the shape and the inner label of an object for each state. Usually the state of an object is 
determined by the value of the variable it monitors. An object that monitors a bit has state 0 (off) and state 1 (on). An object 

d or a double-word can have up to 256 states. 

 Types 
 need the state ct knows how to determine its state. The following table 

describes each of the four state

4.4.1. States of Objects 
When an object has multiple states, its appearance automatically has the same number of correspondi

that monitors a wor

 

4.4.1.1. State
You to specify  type of 

 types. 
an object so the obje

State Type For How to decide the state 
Bit Bit Variable The state is the value of the variable. 

Example: 
1) The state of $U1.3 is 0 when $U1.3 is 0 (off). 

WX3.f is 1 (on). 2) The state of WX3.f is 1 when 
Value , 

Double-word Va
 from 0 to 255. 

ate of $U200 is 123 when $U200 is 123. 
en WX20 is 0. 

 when $N300 is 999. 

Word Variable
riable 

The state is the value of the variable. The valid states are
Example: 

1) The st
2) The state of WX20 is 0 wh
3) The state of $N300 is invalid

LSB Word Va
Double-word V

riable, 
a

s value that is 1 
and state 16 means all 
 are from 0 to 32 and 

H. 
00H. 

N300 is 0. 

riable 
T nificant bit of the variable’
(on). For a word variable, the valid state are from 0 to 16 
the bits are 0. For a double-word variable, the valid state
state 32 means all the bits are 0. 
Example: 

he state is the number of the least sig

1) The state of $U200 is 1 when $U200 is 246
2) The state of WX20 is 19 when WX20 is 800
3) The state of $N300 is 16 when $

Custom Word Variable, 
Double-word Variable 

When you configure an object with the Custom state type, you assign each valid 
state a unique number which is called a state value. The assigned state values 
will be used to determine the state of the object. If the variable’s value is equal to 
one of the state values, the corresponding state of the state value is the state of 
the object. If the value is equal to none of the state values, the state is invalid. 
Example: 
An object monitors $U100 and its state type is Custom. There are three valid 
states and you assigned 300, 200, and 100 to state 0, 1, and 2 respectively. The 
state is 2 when $U100 is 100 and the state is 0 when $U100 is 300. 
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4.4.1.2. Setting the Custom States of an Object 
page of the object’s property dialog box, with the Custom In the General state type selected, click the 

 button to bring up the Custom State Value dialo

 

g box as the example shown below. 

             

You can assign a positive integer for each state in the dialog box. To edit the value, click the row of that state under the 
value column.  

You can use the Move Up button and the Move Down button to adjust the position of state values. To move up or move 
down the state values, you need to make a selection first. To select a state, click the header column. To select multiple 
rows, click the header column and use Ctrl+Click to add a row to the selection. 
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The fo  explains operation options which can  to an object to make it more informative, secure, and 

4.4.2. Operation Options of Objects 
llowing table  be added

useful.  

Terminology Definition 
Enabling and disabling the 
touch operation 

The touch operation can be enabled and disabled either by a specified bit or by the 
n disabled sign on the 

eration is disabled. 

ecify that bit and the bit 
value that enables the touch operation. 

you need to specify the 
 is required to enable the touch operation. 

n dialog box. 

current user level. You can choose to display the touch operatio
button when the touch op
 
If the touch operation is to be enabled by a bit, you need to sp

 
If the touch operation is to be enabled by the current user level, 
lowest user level that
 
Select and set this feature in the Advanced page of the Bit Butto

Requiring the minimum h
time 

sed and held down for 

 
vanced page of the Bit Button dialog box. 

old The touch operation will not be activated until the button is pres
the specified Minimum Hold Time. 

Select and set this feature in the Ad
Requiring the operator 
confirmation 

the button is activated for setting a bit. The 
“Yes” to confirm the operation. 

” to reject the operation 
 Time. 

 

it Button dialog box. 

A confirmation dialog box is displayed when 
button will proceed to set that bit if the operator selects 
The touch operation will be cancelled if the operator selects “No
or if the operator does not respond within the Maximum Waiting

This feature is available for the following operations: 
Set ON, Set OFF, Set ON Pulse, Set OFF Pulse, and Invert. 
 
Select and set this feature in the Advanced page of the B

Notifying a bit of the touc
operation 

ou need to specify the 
 

n dialog box. 

h The notification is performed after the touch operation is done. Y
bit to be notified and the bit value to be used for the notification.
 
Select and set this feature in the Advanced page of the Bit Butto

Logging the touch operat e and date when the touch operation occurs, the new value that is written to the 
 with this feature. 

Select and set this feature in the Advanced page of the Bit Button dialog box. 

ions The tim
bit, and the predefined text can be recorded in the operation log
 

Showing and hiding an o d bit or by the current 
by any of these two 

 
If visibility is to be controlled by a bit, you need to specify that bit and the bit value that 
shows the object. 
 
If visibility is to be controlled by the current user level, you need to specify the lowest 
user level that is required to show the visibility. 
 
Note 1: When an object is invisible, the touch operation is automatically disabled. 
Note 2: It is allowed to simply set an object as invisible. The touch operation is still 
enabled with this setting. 
Select and set this feature on the Visibility page of the object setting dialog box. 

bject The visibility of an object can be controlled either by a specifie
user level, i.e. an object can be shown and hidden dynamically 
methods. 
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and methods to address data. 

4.4.3 ologies for Data Accessing 
able exp

 

4.4.3. Address Settings 
This chapter describes the terms, rules, 

.1. Termin
The following t lains variables, addresses and tags. 

Terminology Definition 
Internal memo y sed by the panel application. For 

tile memory $N, the system memory $S, and 
the recipe memory $R are all parts of the internal memory. 

r The memory space in the target panel that can be acces
example, the user memory $U, the non-vola

Internal variable al memory. An address or a tag referring to an address of a space in the intern
Internal bit variable ternal memory.  

rring to a bit if 

An internal variable that refers to a bit in the in
 
Note: “Internal variable” instead of “internal bit variable” is used when refe
there is no ambiguity. 

Internal word variable variable that refers to a word in the internal memory. 
of bytes (byte array), a 

(double-word array). 

variable” is used when referring to a bit if 

An internal 
The variables can also be used to refer to a double-word, a block 
block of words (word array), and a block of double-words 
 
Note: “Internal variable” instead of “internal bit 
there is no ambiguity. 

External memory aces or the collections of addressable devices in the controllers that can 
ommunication links. 

The memory sp
be accessed by the panel application through c

External variable al memory. An address or a tag referring to an address of a space in the extern
External bit variable 

Note: “External variable” instead of “external bit variable” is used when referring to a bit if 

An external variable that refers to a bit in the external memory. 
 

there is no ambiguity. 
External word variable rs to a word in the external memory. 

 refer to a double-word, a block of bytes (byte array), a 
k of double-words (double-word array) if the access 

ess unit is double-word, you can only 
k of memory space with a length of a 

rring to a bit if 

 An external variable that refe
The variables can also be used to
block of words (word array), and a bloc
unit of the associated addresses is word. If the acc
use the variable to refer to a double-word or a bloc
multiple of 4 (bytes). 
 
Note: ” is used when refe
there is no ambiguity. 

 “External variable” instead of “external bit variable

Variable An internal variable or an external variable. 
Bit variable An internal bit variable or an external bit variable. 
Word variable An internal word variable or an external word variable. 
Double-word variable An internal variable or an external variable that refers to a double-word. 
Byte array variable An internal variable or an external variable that refers to a byte array. 
Word array variable An internal variable or an external variable that refers to a word array. 
Double-word array variable An internal variable or an external variable that refers to a double-word array. 
Tag A name that stands for an address of the internal memory or the external memory. It also 

specifies the data type and scan rate of the data in the memory location it refers to. 
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With the address input keypad, you can enter an address easily. Usually, you click 

4.4.3.2. Address Input Keypad 

 to bring up the address input 
keypad as shown below. 
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Property Description 
Link Click the down arrow and select a link from the drop down list. 
PLC 
Address 

Click the down arrow and select a value
an indirect address between [$I0] and [$I15] as the PLC 

 between 0 and 255 or 

ss. If an indirect address is used, the plc address can be 
ed. 

Addre
dynamically chang

Location 
Type 

own arrow and select an item from the drop down list Click the d
as the location type. 

Address Specify the address. 
Inpu
keypad 

t  
Buttons Description 

 
Clears all the texts in the address field. 

 character to the left of the
field. 

Deletes all selected texts, if any, or the text 
 cursor in the address 

 
Cancels the address inp
dialog. 

ut and escapes the 

Checks and enters the address if valid. 

Others Click to specify the address. Only available 
when the Address field holds the input focus.  

Click the help button to see how to specify word or bit devices 
and their addresses for the specified link in the following 
pop-up dialog. 
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4.4.3.3. Selecting Ta s g

To select a tag, you can click  to bring up the Select T

 

ag dialog box as shown below. 

All the predefined word or bit tags for the 
selected link are listed. To use a tag, you 
can double click the tag you want or select a 
tag and then click the OK button. 

  
 

Note: All the listed tags and tag groups are created in the Tags Editor. To create a tag, please see Section 2.3 Working with 
Tags. 

Selected tag 

The address for the selected tag 

Tag group 
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Th  the following types of objects: 

 
The following are exampl

 

4.4.4. Scale Settings 
is section describes how to set up the scale for

Slide Switch, Bar Graph, Circular Bar Graph, and Meter. 

es of scales used in different kinds of objects. 

CHAPTER 4   DESIGNING SCREENS

 
e in an object's property sheet to set up the scale of that object. The following is an example of

aph. 
You can use the Scale pag  
the Scale page of the bar Gr

 
 

 

Major 
ticks 

Axis 
Minor 

Marks 

Slide Switch 

Bar Graph 

Circular Bar Graph 

ticks 
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The f able describes each property in the Scaollowing t le page. 

Property Description 
Scale Check this item if you want the object to have a scale. 
Position ecifies th he sc e object. T on is relative to the part of the 

object that display le. There are six positio
Sp e position of t ale in th he positi

s the monitored variab ns shown below: 

Position Example Position Example 

 
Bottom Top 

 

 

Left Right 

 

Inner  

 

Outer

 
  

Color the scale. To specify the color, click the corresponding Color icon and select a The color of 
color from the Color palette. 

Number of M r Ticks ecify is two. ajo  m you can spThe number of major ticks. The minimu
Numbe
Divisio

two adjacent major ticks. The minimum you can specify is r of Sub 
ns 

The number of divisions between 
one.  

Axis Check this item if you want the scale to have an axis. 
Marks Check this option if you want the scale to have marks. 
Font The font of the marks. 
Dynamic 
Range 

Check this option if you want the minimum and maximum of the marks to be controlled by 
the dynamic range parameter block of the associated object at runtime. 

Minimum The minimum of the marks. It is a 32-bit integer. 
Maximum The maximum of the marks. It is a 32-bit integer. 
Total Digits The total digits to be displayed for the marks. 

Marks 

Fractional 
Digits 

The number of fractional digits for the marks. For example, when the Maximum = 5000, the 
Total Digits = 4, and the Fractional Digits = 2, the mark for the Maximum will be 50.00. 

 
 



4 4  
 

 

 
4-63 

 

Th

Button, Multi-state Switch, Radio 
Button Group, Step Button, Advanced Numeric Display, ASCII String Entry, and Recipe Selector. 

et

4.4.5. Advanced Settings 
is section describes how to define the advanced settings for the following types of objects: 

Bit Button, Toggle Switch, Screen Button, Function Button, Slide Switch, Word 

You can use the Advanced page in an object's property she

The following are examples of the Advanced page for different obje

 to define the advanced settings of that object.  

cts: 
 

For an advanced numeric display. For a bit button. 

 
 

The following cribe ed page.  table des s each property in the Advanc

Property Description 
Enabled by Bit Check this option so the touch operation of the numeric entry will be enabled and 

disabled by the specified bit. 
Control Bit Specifies the bit that enables and disables the touch .  

Click 

operation

 to enter a bit address. Click  to select a bit tag. 
Enabling State Specifies the state (On or Off) that enables the touch operation. 
Enabled by 
User Level 

Check this item so the touch operation of the numeric entry will be enabled and 
disabled by the current user level. 

Lowest 
Enabling User 
Level 

Specifies the lowest user level that is required to enable the touch operation. 

Touch 
Operation 
Control 

Show Disabled 
Sign 

Check this option so the touch operation disabled sign will be shown on the numeric 
entry when the touch operation is disabled. 

Continued
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Property Description 

Timeout meric keypad does not Check this option so the data entry will be cancelled if the nu
receive any input within the specified time. 

Timeout 

Timeout T um time that the numeric keypad will wait to receive a new input. 
pad will be closed and 

ime Specifies the maxim
If there is no input within the specified time, the numeric key
the data entry will be cancelled. 

Notification ry will notify the specified bit after it finishes 
tputting the entered valu ination variable. 

 Check this option so the numeric ent
ou e to the dest

Signal Selec  t one of the following signals for the notification:

Signal Description 
Level Set the specified bit to the specified state. 
Pulse Send a positive pulse to the specified bit.  

Bit Specifies the bit that receives the notification. 

Notification 

State Specifies the state (On or Off) that is used for the notification. 
Ope
Confirm

rator 
a

he/she enters for the 
 a value is entered for 

ric entry. If the operator selects “Yes” in the Confirmation box, the numeric 
e operator selects “No” 

ond within the specified time period (Maximum 
umeric entry will cancel the data entry operation. 

tion 
Check this option if you want the operator to confirm what 
numeric entry. The Confirmation box will be displayed when
nume
entry will write the entered value to the specified variable. If th
or if the operator does not resp
Waiting Time), the n

Operator 
Confirmatio

Maximum
Waiting T

numeric entry will wait for the operator’s 
ntry will be cancelled if the operator does not respond within 

n 

 Specifies 
ime confirmation. The data e

the maximum time that the 

this time. 
Operation

gging 
 the operation log 

tputs the entered value.

2) The entered value 
3) The predefined operation message 

 Check this option so the following three items will be recorded in
when the numeric entry ou  Lo
There are three recorded items: 
1) The time when the operation is performed 

Message

Operation 
Logging 

 Enter the operation message of the first language here. 

 
Click this button to bring up the Operation Message dialog box that you can edit the 
operation message for all the languages. 

Minimum Hold Time Available when the object is a button or switch. The touch operation of the button will 
not be activated until the button is pressed and held down for the specified time 
period (Minimum Hold Time). 
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In the Visibility page of an object's property sheet, you can define how to show and hide the object. You can also modify 

4.4.6. Visibility Settings 

the position and size of an object with the Visibility page. 

The following are examples of the Visibility page: 
 

The option “Controlled by Bit” is checked The option “Controlled by User Level” is checked 

The following table describes  p each roperty in the Visibility page. 

Property Description 
Invisible Check this option so the object will always be invisible. 

this setting. Note: The touch operation is still enabled with 
Controlled by Bit Check this option so the object will be shown and hidden by the specified bit. 
Control Bit
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 Specifies the bit that will show or hide the object.  

Click  to enter the bit address. Click  to enter the bit tag. 

Controlle
by Bit 

d

  that makes the object visible. 

 

Visible State Specifies the state (On or Off)
Controlled by
User Level 

own and hidden by the current user level.  Check this option so the object will be shControlled 
by User 
Level Lowest Visible 

 
Specifies the lowest user level that is required to show the object. 

User Level
Left Specifies the X coordinate of the object’s upper-left corner on the screen. Dimension 
Top Specifies the Y coordinate of the object’s upper-left corner on the screen. 
Width Specifies the width (in pixels) of the object. 
Height Specifies the height (in pixels) of the object. 

 Click this button to redraw the object with the new settings. 
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